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Interface

Toolbar

Menus

Options
bar

Document
window

Collapsed
panels

Panel
title bar

Collapse 
to icons 
button

Panels

Custom
spaces

Under the Window menu, 
highlitht Workspace. There will 
be several default spaces in the 
popup menu that will change 
the choice and appearance of 
panels and bars.

You can save your own custom 
workspace. Arrange panels and 
bars the way you want, then 
select Save Workspace . . .  

Saved workspaces

Default
spaces
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Fit in window Cmd 0 (zero)
Actual size Cmd 1
Zoom in Cmd +
Zoom out Cmd -
Zoom tool Cmd Space bar (hold down)
Zoom out tool Cmd Opt Space bar (hold down)
Hand tool Space bar (hold down)

Keyboard
commands

Cmd: Apple key
Opt: Option key

Navigation: Panning and zooming

Use the Hand Tool to move around your document window. 
But instead of going to the Toolbox to get the Hand Tool, 
simply hold down the Space Bar with any other tool selected 
(except the Text Tool), and the Hand Tool will appear.

Spacebar = Hand Tool

Hold down the Command key and the Space Bar at the same 
time. Whatever tool you have selected will change to the Zoom 
In Tool - drag a marquee over the area you want to zoom in on.

Command, Option and Space Bar will make the Zoom Out 
Tool appear — click anywhere on your document to zoom out.

Command + space Bar = Zoom Tool

The Command key and the Plus Key will zoom in one step; 
the Command key and the Minus Key will zoom out one step.

The Command key and the numerical Zero Key will �t your 
document in your window.
The Command key and the One Key will take you to 100% 
view, or actual  size.

Zoom In Or Out Incrementally

In the bottom left corner of your document window is a �eld 
that shows current magni�cation. Highlight that number and 
type in the magni�cation level you want and hit enter.

Or, open the Navigator Palette from the Window menu. Move 
the red box around to reposition your view, or use the 
magni�cation slider on the bottom.

Other Methods

HAND TOOL
ZOOM TOOL
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View commands

Preview/outline view Cmd Y
Show/hide guides Cmd ;
Lock/unlock guides Cmd Opt ;
Show/hide edges Cmd H
Show/hide page rulers Cmd R

View

Toggle between Preview and Outline views: Command-Y

Show/hide guides: 
 Command-Semicolon

Show/hide rulers: Command-R 
Drag guides from rulers onto document.

Lock/unlock guides: 
 Command-Option-Semicolon

Show/hide highlighted edges of selected objects: Command-H

Make guides: Command-5
Any selected object can be made 
into a guide. 
Any selected guide can be released 
back to an object with its previous 
attributes: Command-Option-5

View menu
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Paths and points
In Illustrator, shapes that you create are called paths. You can modify the color and width of 
the outline, or stroke, and the type and color of the �ll, the area inside the stroke. The �ll can 
be a single color, a gradient—a blend between two or more colors—or a pattern.

A path is composed of anchor points and segments that join the points. 

When a path is selected, its bounding box appears. The bounding box has handles in each 
corner and in the middle of each side that can be used to resize the path.  

There are two types of anchor points: Corner and Smooth. Smooth points have curved 
segments between them, and have control handles that can be used to modify the curve of 
the segment. 

Anchor points and control handles are only visible when a path is selected. They don’t print 
or show up in the �nal artwork. 

STROKE
FILL

ANCHOR POINTS

SEGMENT

PATH

Bounding box

Corner point

Straight segment
Curved segment

Smooth point

Control handle

Handle
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Selection Tools

Selection tool (black arrow) V
Direct Selection tool (white arrow) A
Group Selection tool (white arrow +) Opt (hold down)
Toggle between black and white arrows Cmd (hold down); Cmd Opt Tab
Lasso Q
Magic Wand Y

Select

Group Selection tool: 
First click selects individual path, 
second click selects all paths that 
it’s grouped with. 

• Click and drag with any of the selection tools to select 
multiple paths or parts of paths.

• Shift-click on additional paths after one is already 
selected. Also deselects an already selected path.

Selecting multiple paths

Direct Selection (white arrow) selects individual points or segments,
that is, parts of paths. 

Magic Wand selects all paths in a document with the same 
or similar �ll attributes.

Lasso Tool selects paths or parts of paths by dragging  a marquee 
around all or part of the paths. 

Selection Tool (black arrow) selects entire paths. 

(Click and hold lower right corner of 
tool to make popup menu appear)
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Transforming paths

Rotate

Scale

Warp

Free
Transform

Eraser

Submenus

Scale S
Rotate R
Reflect O
Free Transform E
Scissors  C
Eraser Shift E
Toggle stroke/blend X
Delete stroke/blend /
Swap stroke/blend Shift X

Transform

Most of the tools, such as Scale or Rotate, work 
the same way: 

• Select the path or part to be transformed
• Select the tool
• Click once to establish the point of origin
• Click and drag at another spot on the 
document (usually diagonally from the point 
of origin) to perform the transformation.

Hold down Shift as you drag to constrain 
proportions in Scale or to 45 degree 
increments in Rotate or Re�ect.

Hold down Option as you drag to make a copy 
of the path being transformed.

Select path

Select scale tool; click on 
spot where scaling will 
originate from

Click and drag down 
and away from �rst 
click spot. Hold shift 
key to constrain 
proportions.

Click
here

Click and drag herex

(Click and 
hold lower 
right corner 
of tool)
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STRAIGHT TO CURVED

CURVED TO STRAIGHT

With Pen Tool selected, click a point and then a second 
point. This creates two anchor points joined by a 
straight stroke.

Click and drag on the second point, creating a control 
handle. Notice how the Pen Tool changes in appearance 
when over point 2, and when dragging out the handle.

Click and drag a third point, creating an anchor point 
with two handles. The stroke joining points 2 and 3 is 
curved, and the curve can be adjusted by clicking and 
dragging on the small points at the ends of the handles.

Click and drag a fourth point. Again, the stroke 
between points 3 and 4 will be curved and 
adjustable with the handles.

Click once on the fourth point. This 
eliminates its front handle, but leaves the 
one in back that controls the stroke 
between points 3 and 4.

Click once to make a �fth point, without 
dragging. The stroke between points 4 and 5 
will be straight, with no handles.

The entire path will be de�ned by �ve points 
connected by two straight strokes and two 
curved strokes. Points 1 and 5 will have no 
handles, points 2 and 4 will have one handle 
each, and point 3 will have two handles.

1 2

3

45

Click and drag

Click

Click Click

Click and drag

Click and drag

Pen Tool: Drawing straight and curved paths
Clicking once with the Pen tool creates an anchor point for a straight stroke. 
Clicking and dragging creates an anchor point for a curved stroke. The curved anchor point will 
have control handles.
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CLOSING THE PATH
With point 5 still selected with the Pen tool — it 
will be solid instead of hollow — move the Pen 
tool over point 1. A circle will appear next to the 
cursor when it is directly over the point. Click 
once to close the path, or click and drag to add a 
single handle to point 1.

REMOVING POINTS
With the path selected, placing the Pen 
tool over any anchor point will cause a 
minus sign to appear next to the cursor. 

ADDING POINTS
Placing the Pen tool over any part of a selected 
stroke will cause a plus sign to appear. 
Clicking on the stroke will add an anchor point.

CHANGING FROM STRAIGHT 
TO CURVED
Place the Pen tool over a point and hold down 
the Option key. The cursor will change to the 
Convert Anchor Point tool. Clicking and 
dragging on a straight anchor point will add 
handles to it; clicking on a curved anchor point 
will remove its handles.

Clicking on the point will delete the point.

1

5

Close-path symbol

Solid blue anchor point

New anchor point

Option-click and drag

Pen Tool: Closing paths; altering points
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Changing stroke and �ll colors

Choose the color space for the sliders from the 
popup menu at upper right. Drag the sliders, or 
type in percents in numerical �elds.

You can also click on a color in the Spectrum, or on 
the No Color icon.

Change the �ll and stroke colors of a 
selected shape by clicking on a color in 
the Swatches Panel, or by mixing a color 
using the sliders in the Color Panel. 

COLOR PANEL

SWATCHES PANEL

FILL
STROKE

CMYK
Spectrum

SWATCHES

FILL/STROKE ICONS

Last Color

No Color

Swatch
Libraries

Swatch
Kinds

Swatch
Options

New
Color
Group

New
Swatch

Delete
Swatch

CMYK Sliders

Swatches can be colors, textures or gradients. Choose which types 
to show by clicking on the Swatch Kinds icon at the bottom.

A color mixed in the Color Panel can be dragged onto the Swatches 
Panel to save it as a new swatch. 

Swatches can be rearranged in the panel by dragging them to new 
positions, or deleted by dragging them to the Trash Can icon at the 
lower right corner of the panel.

STROKE PANEL
Change stroke width in the Weight �eld. Use 
up-down arrows, pop-up menu, or highlight 
the �eld to enter a number, such as 2.5 pt.

Check Dashed Line to make dashes, and 
enter dash and gap lengths in points.

Cap type

Up-Down
arrows

Pop-up
menu

Join type

Stroke
active

Fill
active

The Fill/Stroke icon is in the 
Color Panel and also at the 
bottom of the Tool Bar. 
Choose to make the stroke 
or �ll active by clicking on 
the lower right or upper left 
boxes respectively.
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Gradients
GRADIENT PANEL
To change a path’s �ll to a gradient, select 
the path and click on the Gradient Fill 
icon in the Gradient panel. At �rst, it will be 
a generic white-to-black, horizontal 
gradient, but you can modify its colors and 
direction. You also have the option of two 
types: linear or radial. 

Changing colors
The gradient slider in the panel has markers 
on it that determine the colors to be 
blended. There are two ways to change a 
marker’s color:
• Drag a swatch from the Swatches panel 
onto the marker
• Click on the marker, which will make its 
color appear in the Color panel. Adjust the 
Color panel sliders to create a new color. 

Adding colors
Click anywhere on the Slider, or drag a color 
swatch anywhere on it, to make a new marker. 
The markers can also be moved to a di�erent 
spot by dragging them. 

To delete a marker, drag it o� of the Slider. 

The diamond shapes at the top of the Slider 
indicate midpoints of blends. They can be 
changed by dragging, or by entering a percent 
in the Location �eld. 

Changing direction
The Gradient Tool in the toolbar is 
used to change the gradient’s 
direction. With the path selected, 
drag the tool across it in the desired 

direction. The bar that appears across the 
path is interactive: grab the endpoints to 
reposition them, and slide the color 
markers to reposition them.

The direction can also be changed by 
entering a number in the Angle �eld in 
the panel.

Gradient
Fill icon

Gradient
Slider

Color
Marker

Midpoint
Marker

Color
Marker

Click on marker to change its 
color, or drag a swatch onto it

Click to add a new marker

Path with
linear, radial �lls

Drag tool across selected path

Click and drag 
end points

Drag 
markers

Drag to change  
midpoints of 
blends
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Cmd: Apple key
Opt: Option key

Paste in front (of selected object) Cmd F
Paste in back Cmd B
Lock Cmd 2
Unlock all Cmd Opt 2
Hide Cmd 3
Unhide all Cmd Opt 3

Path
options

1. Select circle 
and choose Cut 
under Edit menu

2. Select 
rectangle

3. Choose Paste 
in Front under 
Edit menu

Arranging paths
There are two ways to move paths in front of 
or in back of each other:

ARRANGE MENU
Arrange under the Object menu gives you four 
options to move a path in relation to others on the 
same layer.

PASTE COMMANDS
Paste in Front / Paste in Back commands under the Edit menu 
allow you to place a path directly in front of or in back of another 
path without changing its location on the page:
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Layers
Paths can exist on any layer in the 
Layers menu, which is where you 
can create or delete layers, move 
layers above and below each other, 
and move selected paths from one 
layer to another. 

Delete
selected layer

Selected path:
Slide square to 
another layer 
to move the path
there

Drag the layer 
above or below
other layers

Create
new layer

Active
layer

Click to show / hide sublayers

Layers popup menu

Click to 
show/hide

Click to 
lock/unlock

When a path or group is selected, a small square 
will appear to the right of the layer that it’s 
occupying. Click and slide the square up or down 
to move the path or group to another layer.

CAUTION! Clicking on the right side of a layer 
selects all the paths on that layer. Make sure to 
select the path you want to move �rst, then slide 
its square to the desired layer by dragging.

Sublayers
Each layer has a triangular icon to the left of its 
name. Clicking on it expands the layer to reveal all 
the paths on that layer. 

Moving a shape to a di�erent layer

Move a layer up or down in the panel by simply 
dragging it above or below the other layers. 

CAUTION! Dragging a layer directly on top of 
another layer will convert it into a sublayer inside 
that layer. It will then only be visible by expanding 
the layer: see Sublayers below. Be sure to drag the 
layer to a spot in between other layers.

Moving layers

Selected path. It 
can be dragged 
above or below 
other paths.
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BLENDING MODES
The Transparency Panel allows you to change 
how a selected path interacts with paths 
beneath it. The Blending Modes each have a 
di�erent e�ect: Experiment with them to see 
what they do.  

Illustrator’s blending modes are identical to 
Photoshop’s. However, in Photoshop they are 
applied to layers rather than selected paths.

OPACITY
Opacity simply means how transparent a path is, 
determined by percentage: The lower the 
percentage, the more transparent the object is. 

BLENDING MODE EXAMPLES
With orange circle selected:

OPACITY LEVELS

Normal

Di�erence

100% 75% 50% 25%

Hue Luminosity

Multiply Screen Hard Light

Blending
Modes

Opacity

Transparency
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Blarney

Stone

Blarney

Stone

A clipping mask is a path that acts as a frame or 
container for something underneath it. Any part 
of underlying paths that lie outside of the mask 
will be hidden (although it can still be selected.)

The command is under the Object menu: 
Clipping Mask: Make.

To make one, select any number of overlapping 
paths and use the Make command. Whatever is 
the topmost path will become the mask for all 
underlying paths. 

The keyboard shortcut is Command-7.

The Release command is in the same submenu 
(Command-Option-7).

To see, select and modify parts of paths 
hidden by the mask, you can either release 
it temporarily, or switch to Outline View in 
the View menu (Command-Y toggles 
between Preview and Outline).

Be aware that selecting paths on multiple 
layers and applying a mask to them will 
move them all to the same layer as the 
mask. It also groups all the paths: Use the 
Group Selection Tool (White arrow with 
plus sign) to select paths within the group.

Draw a path that will 
become the mask

Select all, including the 
mask path

Make Clipping Mask

Outline View

Notice that the mask 
path loses all its stroke 
and �ll attributes

Clipping masks
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INTERLOCKING PATHS

Create two paths

Creating a compound path is like cutting 
a hole in a path. It’s made by drawing a 
path in front of another path, selecting 
both, and choosing Make Compound 
Path under the Objects menu.

The keyboard shortcut is Command-8.

The release command is in the same 
place — that will make the paths 
separate again. 
(Command-Option-Shift-8).

Select both; choose 
Make Compound Path 

in Objects menu

1. Create shapes 2. Make Compound Paths

3. Cut top ring 
with Scissors tool

4. Delete cut
sections

5. Use Pen Tool to connect
paths

Draw a circle, copy it and paste it in 
front of itself, then scale it down. 
Select both circles and make com-
pound path. 
Repeat for the other ring. 
Use Scissors Tool (subset of Eraser) 
to cut top ring where it intersects 
bottom ring. Select cut sections 
with White Arrow and delete. Use 
Pen Tool to connect inner and 
outer parts.

1

23

4

Delete Delete

Delete

Compound paths
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LINK OPTION

Place dialog boxLink vs. Embed

Work�ow
To place a Photoshop image in an Illustrator document:

• In Illustrator, create a new, blank 
document in the desired color 
space (CMYK or RGB).

• Under the File menu, select the 
Place command.

• Locate the Photoshop document 
and click Place. Make sure the 
Link option is checked on.

The two documents should be 
kept in the same location: on your 
desktop or in a folder.

PHOTOSHOP
DOCUMENT:
japan07.psd

ILLUSTRATOR
DOCUMENT:

japan07_trace.ai

Photoshop images can be placed in an 
Illustrator document to either trace 
from or to be used as part of the 
document. The Photoshop document 
will be nested inside the Illustrator 
document. But you need to know the 
di�erence between the two documents 
and keep track of them.

When you use the Place command, you have the option of 
linking to the Photoshop document or embedding it. To 
link, make sure the Link option is checked on in the Place 
dialog box.

IF YOU LINK: The Photoshop document has to accompany 
the Illustrator document wherever it goes. If you copy the 
Illustrator document to your �ash drive, you have to copy 
the Photoshop document along with it, to the same place. 

The Photoshop document will be embedded if the Link 
option is unchecked. Then, the Photoshop image will 
become part of the Illustrator document  and doesn’t have to 
accompany the Illustrator document if it’s copied or moved.

Placing images
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RELINK
GO TO LINK EDIT 

ORIGINALUPDATE LINK

Links Panel
As you place images in the 
Illustrator document, they 
will be listed in the Links 
panel.

The popup menu in the 
upper right corner o�ers a 
list of options for any of the 
links selected in the panel. 

Advantages of linking:
If any changes are made to the Photoshop document, they’ll be updated in 
the Illustrator document. 

Keeps the Illustrator document �le size smaller.

Advantages of embedding:
You don’t have to worry about keeping the Photoshop document with the 
Illustrator document. 

If changes are made to the Photoshop document, you can still update it, 
you just have to do it manually through the Links panel.

Placing images cont.



Fit in window Cmd 0 (zero)
Actual size Cmd 1
Zoom in Cmd +
Zoom out Cmd -
Zoom tool Cmd Space bar (hold down)
Zoom out tool Cmd Opt Space bar (hold down)
Hand tool Space bar (hold down)

Navigate

Preview/outline view Cmd Y
Show/hide guides Cmd ;
Lock/unlock guides Cmd Opt ;
Show/hide edges Cmd H
Show/hide page rulers Cmd R

View

Selection tool (black arrow) V
Direct Selection tool (white arrow) A
Group Selection tool (white arrow +) Opt (hold down)
Toggle between black and white arrows Cmd (hold down); Cmd Opt Tab
Lasso Q
Magic Wand Y

Select

Type T
Tab ruler Cmd Shift T
Align left Cmd Shift L
Align right Cmd Shift R
Align center Cmd Shift C
Show hidden characters (toggle) Cmd Opt I

Type

Pen P
Add Anchor Point +
Delete Anchor Point - 
Convert Anchor Point Shift C
Rectangle  M
Ellipse L

Tools

Scale S
Rotate R
Reflect O
Free Transform E
Scissors  C
Eraser Shift E
Eyedropper I
Gradient G
Blend W
Toggle stroke/blend X
Delete stroke/blend /
Swap stroke/blend Shift X

Transform

Group Cmd G
Ungroup Cmd Shift G
Lock Cmd 2
Unlock all Cmd Opt 2
Hide Cmd 3
Unhide all Cmd Opt 3
Paste in front (of selected object) Cmd F
Paste in back Cmd B
Clipping mask Cmd 7
Clipping mask release Cmd Opt 7
Compound path Cmd 8
Compound path release Cmd Opt 8

Arrange

Select all Cmd A
Deselect all Cmd Shift A
Repeat previous action Cmd D
Make guide (from selected object) Cmd 5
Release guide Cmd Opt 5
Repeat previous select Cmd 6
Repeat previous pathfinder  Cmd 4

Other

Cmd: Apple key
Opt: Option key

Keyboard shortcuts (M
ac)



Fit in window Ctrl 0 (zero)
Actual size Ctrl 1
Zoom in Ctrl +
Zoom out Ctrl -
Zoom tool Ctrl Space bar (hold down)
Zoom out tool Ctrl Alt Space bar (hold down)
Hand tool Space bar (hold down)

Preview/outline view Ctrl Y
Show/hide guides Ctrl ;
Lock/unlock guides Ctrl Alt ;
Show/hide edges Ctrl H
Show/hide page rulers Ctrl R

Selection tool (black arrow) V
Direct Selection tool (white arrow) A
Group Selection tool (white arrow +) Alt (hold down)
Toggle between black and white arrows Ctrl (hold down); Ctrl Alt Tab
Lasso Q
Magic Wand Y

Type T
Tab ruler Ctrl Shift T
Align left Ctrl Shift L
Align right Ctrl Shift R
Align center Ctrl Shift C
Show hidden characters (toggle) Ctrl Alt I

Pen P
Add Anchor Point +
Delete Anchor Point - 
Convert Anchor Point Shift C
Rectangle  M
Ellipse L

Scale S
Rotate R
Reflect O
Free Transform E
Scissors  C
Eraser Shift E
Eyedropper I
Gradient G
Blend W
Toggle stroke/blend X
Delete stroke/blend /
Swap stroke/blend Shift X

Group Ctrl G
Ungroup Ctrl Shift G
Lock Ctrl 2
Unlock all Ctrl Alt 2
Hide Ctrl 3
Unhide all Ctrl Alt 3
Paste in front (of selected object) Ctrl F
Paste in back Ctrl B
Clipping mask Ctrl 7
Clipping mask release Ctrl Alt 7
Compound path Ctrl 8
Compound path release Ctrl Alt 8

Select all Ctrl A
Deselect all Ctrl Shift A
Repeat previous action Ctrl D
Make guide (from selected object) Ctrl 5
Release guide Ctrl Alt 5
Repeat previous select Ctrl 6
Repeat previous pathfinder  Ctrl 4

Navigate

View

Select

Type

Tools

Transform

Arrange

Other

Keyboard shortcuts (PC
)


